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No Warranty
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IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
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THE USER'S PARTICULAR NEEDS; (III) DTS DOES NOT WARRANT THAT THE 
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FOR ANY INCIDENTAL, INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES 
(INCLUDING BUT NOT LIMITED TO DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, AND LOSS OF BUSINESS INFORMATION) ARISING OUT 
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1  Introduction

Neural UpMix is a groundbreaking plug-in for the post-production and mixing communities. 
Combining precision and creative flexibility, it can output 5.1 or 7.1 multi-channel stems from 
stereo or 5.1 source material and is intended for projects where the original source elements for a 
conventional upmix are not available. It is especially useful for catalog films, TV series, docu-
mentaries, menus, deleted scenes, and featurettes.
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2  System Requirements

2.1  Software Requirements

Microsoft Windows XP SP2 or greater, or Vista Business

Apple Macintosh running OS X 10.4.8 or greater

Pro Tools HD or LE* 7.4 or greater, or a VST Compatible Host (e.g.Steinberg Nuendo)
*LE requires Production Toolkit

2.2  CPU Requirements

Processor: Intel Core 2 Duo, 2.2 GHz or faster

Memory: 2 GB

Hard Drive: Separate Data Drive for audio and video files, 7200 RPM SATA

2.3  iLok Usage

Neural UpMix by DTS is an iLok-enabled software product. Because Neural UpMix is a down-
load-only product, the iLok license code is issued during purchase. Once the iLok license code is 
redeemed and synchronized to an iLok Smart Key at iLok.com, the Smart Key will contain the 
license and authorizations necessary to activate and run the software you purchased. Simply insert 
the Smart Key into the USB slot and the system is ready for use. It is strongly recommended that 
once the Neural UpMix application is running, that the iLok Smart Key remain in the USB slot. 
Removing the Smart Key while the application is running may result in runtime application 
errors. The license may be transferred from one iLok Smart Key to another. Please refer to "Man-
age Your iLok" on the iLok website located at  http://www.ilok.com.
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3  Main Screen

Figure 3-1 shows the main screen of the Neural UpMix.

Figure 3-1

The main screen has 3 sections: Input, Settings, and Output.

3.1  Input

The input section of the main screen displays meters that match the channel count of the input sig-
nal.  If the input source is stereo, there will be 2 input meters. If the input source is 5.1, there will 
be 6 input meters.

The yellow bar indicates the instantaneous audio level of the channel (see Figure 3-2).  The thin 
yellow line shows the peak level over the past second. Below the meter is a numerical readout of 
the peak level (the level at the thin yellow line).

At the very top is a small rectangle that indicates whether clipping has occurred. The rectangle is 
red if clipping has occurred in the channel, and black if clipping has not occurred. The clipping 
indicator remains red until it is manually reset. Clicking any of the clipping indicators will reset 
the clipping indicators on all channels.
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Figure 3-2

3.2  Settings

The Settings section is in the middle of the main screen. In the Settings, you can adjust the param-
eters that determine how the sound is processed during upmixing.

3.2.1  Depth

The Depth control allows you to adjust the balance between front and surround speakers during 
the upmix process. Moving the slider up shifts the balance toward the front speakers, and moving 
it down shifts the balance toward the rear speakers. The box below the slider gives a numeric indi-
cation of the balance (see Figure 3-3).

Figure 3-3

peak level

current level

numerical value of 
peak level

clipping indicator
4Confidential - Do NOT Duplicate
18169v3

DTS Document Number 9302J70400B



User Guide,
Neural™ UpMix by DTS
When the slider is in the center, the indicator at the bottom displays "Auto". This default Auto set-
ting results in an unbiased upmix based on the phase and intensity of the input material.  As the 
slider moves toward the bottom, the indicator shows a down-arrow to indicate that the balance is 
weighted toward the surround speakers. When the slider is moved above the center, the indicator 
shows an up-arrow to indicate that the balance is weighted toward the front speakers. The percent-
age goes from 1 to 100.

3.2.2  Width

In speaker systems that have Left, Right, and Center speakers, a sound in the center can be repro-
duced either by playing it out of the Center speaker, or by playing it at equal volume out of the 
Left and Right speakers, creating a "phantom" center. The choice of whether to have a "true" cen-
ter or a "phantom" center is an artistic decision. A true center results in a highly focused sound, 
whereas a phantom center presents a sound that appears to be much wider upon playback.

The Width control determines whether the Center channel information will be played as a true 
center, a phantom center, or a blend of the two (see Figure 3-4). When the control is completely to 
the right, the Center sound will be a phantom center, and the indicator at the right will show 
"100%". When the control is all the way to the left, all of the Center sound will be a true center 
coming out of the Center speaker, and the indicator at the right will show "Auto". This default 
Auto setting relies on phase and intensity offsets to determine the placement of the Center image.  
If the control is anywhere in the middle, the indicator will show the percentage of the Center 
sound that is processed as a phantom center.

Figure 3-4

3.2.3  Surround Channels

When upmixing from stereo to 7.1, two slightly different output speaker configurations are avail-
able. In one layout, "Lss/Rss", the middle surround speakers are positioned at the side of the lis-
tener (+/- 90 degrees). In the other layout, "Ls/Rs", the middle surround speakers are positioned 
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slightly to the rear of the listener (+/-110 degrees). Neural UpMix shows a diagram of the selected 
speaker configuration (see Figure 3-5).

Figure 3-5

3.2.4  The About box

Clicking on “Neural Upmix” on the left side of the title bar brings up the About box, with infor-
mation about this plug-in. The About box appears where the speaker layout is normally shown.

3.2.5  LFE 80 Hz Low Pass Filter

This button turns on a filter that removes all frequencies above 80 Hz from the LFE channel. The 
button is illuminated blue when it is on (see Figure 3-6). The default state is enabled.  If the button 
is disabled, the LFE is unprocessed.

In the 2.0-to-5.1 and 2.0-to-7.1 cases, the generated LFE will contain frequencies up to 80 Hz if 
this button is enabled. If this button is disabled, the generated LFE will contain frequencies up to 
120 Hz.
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Note: This button should not be confused with bass management, which is not a feature of the 
Neural UpMix plug-in.

Figure 3-6

3.3  Output

The output section has metering, soloing, and gain trim for each channel, plus a limiter that oper-
ates on all channels (see Figure 3-7).

Figure 3-7

3.3.1  Output Level Meters

The yellow bar indicates the instantaneous audio level of the channel (see Figure 3-2). The thin 
line above it shows the peak level over the past second. Below the meter is a numerical readout of 
the peak audio level.

peak level

current level

numerical value of current level 

solo button 

gain trim

clipping indicator
7Confidential - Do NOT Duplicate
18169v3

DTS Document Number 9302J70400B



User Guide,
Neural™ UpMix by DTS
At the very top is a small rectangle that indicates whether clipping has occurred. The rectangle is 
red if clipping has occurred in the channel, and black if clipping has not occurred. A clipping indi-
cator remains red until it is manually reset. Clicking on any of the clipping indicators will reset the 
clipping indicators on all channels.

3.3.2  Solo Button

When a Solo button is enabled, it will turn blue, and it will mute all other channels. Clicking the 
Solo button again will turn Solo off.

You can solo multiple channels by clicking on additional Solo buttons.

3.3.3  Gain Trim

The gain trim allows you to fine tune the balance of the resulting upmix.

Clicking on the "+" or "-" buttons increases or decreases the output gain by 0.5 dB per click. The 
gain of each channel can be adjusted by a maximum of +/- 9 dB.

3.3.4  Limiter

The output section has a limiter that can be used to limit the output level of all channels. When 
you click on the Enable button, the button becomes blue, and the limiter becomes active. The
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"Ceiling" slider sets the maximum output level in dB. This level is displayed in the window under 
the slider (see Figure 3-8).

Figure 3-8

Note: The channel gain trims are applied post limiter.
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4  Using the Neural UpMix RTAS plug-in in Pro Tools

Due to the upmixing process, the Neural UpMix plug-in will not have the same number of inputs 
and outputs. For example, if you are upmixing from stereo to 7.1, the Neural UpMix plug-in will 
have 2 inputs and 8 outputs.

The track that you insert the plug-in on must match the same number of channels as the inputs of 
the plug-in. So, if you are doing a stereo-to-7.1 upmix, you must start by creating a stereo track. 
When you insert the Neural UpMix plug-in on the track, the list of inserts will show the Neural 
UpMix versions that have a stereo input (see Figure 4-9).

Figure 4-9

If you select, for instance, the stereo/7.1 plug-in, Pro Tools will reconfigure that track to have 8 
outputs. You will notice that Pro Tools changes the track display to show 8 output meters (see Fig-
ure 4-10).

Figure 4-10

You will now need to assign outputs to this track, and you will see that Pro Tools will only offer to 
connect a 7.1 bus.
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You are now ready to upmix! Import a stereo sound file on the track and hit play to listen in real-
time, or you can Bounce to Disk to capture the upmixed file.

In the 5.1-to-7.1 case, the 5.1 audio track is expected to contain input channels ordered according 
to the standard Pro Tools 5.1 channel order:

1)  L
2)  C
3)   R
4)   Ls
5)   Rs
6)   LFE

Note: The Lsr and Rsr output channels are sent to the channels Pro Tools defines as Lc and Rc, 
respectively.

Note: The plug-in does not currently support Touch or Touch/Latch automation.

4.1  Live Inputs

When you turn on the live input monitor on a Pro Tools Audio Track, Pro Tools automatically 
bypasses the plug-ins on that track. So, if you want to use Neural UpMix with a live input, you 
must place the plug-in on a separate track, and feed the audio from the track with the live input to 
the track with the Neural UpMix plug-in. Here is the procedure:

1) Create an Audio Track with the appropriate number of input channels, and an Aux 
Track with the correct number of output channels. For instance, if you are doing a stereo-
to-5.1 upmix, create a stereo Audio Track and a 5.1 Aux Track.

2) Insert the Neural UpMix plug-in on the Aux Track.

3) Create a Bus Path with the number of output channels, and then create a Sub-Path of 
that bus with the number of input channels. For instance, on a stereo-to-5.1 upmix, create 
a 5.1 Bus Path, and then create a stereo Sub-Path of that Bus.

4) Assign the Bus Path to the input of the Aux Track, and the Sub-Path to the output of the 
Audio Track. This passes the audio from the input track to the plug-in's track.

5) Assign an output to the Aux Track (this should match the number of output channels - 
5.1 in this example), and turn on the live input monitor on the Audio Track.
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Now you can upmix in real-time with live audio. The output can be monitored in real-time, or be 
bounced to disk.
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5  Using the Neural UpMix AudioSuite plug-in in Pro Tools

The AudioSuite version of Neural UpMix must be used with mono tracks in Pro Tools in order to 
allow a different number of input channels and output channels.

Let’s say, for instance, that you want to perform a stereo-to-5.1 upmix. First, you must create a 
Pro Tools project that contains mono tracks equal to the number of desired output channels. In this 
case, we need 6 mono tracks. Next, we load the L and R channels of the stereo file into the first 
two tracks of the project (see Figure 5-11).

Figure 5-11
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Group the tracks. To do this, you must first select an area the same length as the sound files, 
across all 6 tracks (see Figure 5-12).

Figure 5-12
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Right-click on the selected area to bring up the right-click menu (see Figure 5-13). Select the 
Group menu item.

Figure 5-13
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Pro Tools will now show the 6 tracks grouped together  (see Figure 5-14).

Figure 5-14

Go to the AudioSuite menu and select the UpMix that you want.  In this case, select 2.0 to 5.1 (see 
Figure 5-15).

Figure 5-15
16Confidential - Do NOT Duplicate
18169v3

DTS Document Number 9302J70400B



User Guide,
Neural™ UpMix by DTS
On the plug-in, you must set the "playlist"/"region list" button to "playlist" (see Figure 5-16).

Figure 5-16

Note: The AudioSuite plug-in does not currently support the use of presets saved within the RTAS 
plug-in, and vice-versa.

set to “playlist”
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You are ready to upmix. Click on the Process button to generate the 6 channels of upmixed audio 
(see Figure 5-17).

Figure 5-17

Note: The resulting files are output according to the standard Pro Tools 5.1 channel order:
1)  L
2)  C
3)  R
4)  Ls
5)  Rs
6)  LFE
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6  Using the Neural UpMix plug-in in Nuendo

Due to the upmixing process, the Neural UpMix plug-in will not have the same number of inputs 
and outputs. For example, if you are upmixing from stereo to 7.1, the Neural UpMix plug-in will 
have 2 inputs and 8 outputs.

In Nuendo, you must create a track that has the same number of channels as the output of the Neu-
ral UpMix plug-in. So, if you do a stereo-to-5.1 upmix, you need a track with 6 channels. If you 
do a stereo-to-7.1 upmix or a 5.1-to-7.1 upmix, you need a track with 8 channels. To add a track, 
go to Project > Add Track > Audio, and in the Configuration section, select the number of tracks 
(see Figure 6-18). Connect the output of this track to an output bus with the correct number of 
channels.

Figure 6-18

Next, drag the input audio file onto the newly created track. The plug-in accepts both interleaved 
stereo and interleaved 5.1 files. If you drag an interleaved stereo file onto a 5.1 or 7.1 track, 
Nuendo will put the input channels onto the first two channels of the track. If you drag an inter-
leaved 5.1 file onto a 7.1 track, Nuendo will put the input channels on the first 6 channels of the 
track (see Figure 6-19).

Figure 6-19
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Then, go to the Inserts and select the Neural UpMix plug-in. This will bring up the Neural UpMix 
user interface (see Figure 6-20).

Figure 6-20

Now when you play the input track, it will be processed through the Neural UpMix plug-in.
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To capture the upmixed audio, first you must select the waveform region to capture by moving the 
small triangles on the timeline. Then go to File > Export > Audio Mixdown. It will bring up a 
window where you will set the parameters for the capture to file (see Figure 6-21).

Figure 6-21

Click on the Export button to capture the output file.
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	Note: The plug-in does not currently support Touch or Touch/Latch automation.
	4.1 Live Inputs

	When you turn on the live input monitor on a Pro Tools Audio Track, Pro Tools automatically bypasses the plug-ins on that track. So, if you want to use Neural UpMix with a live input, you must place the plug-in on a separate track, and feed the audio...
	Now you can upmix in real-time with live audio. The output can be monitored in real-time, or be bounced to disk.
	5 Using the Neural UpMix AudioSuite plug-in in Pro Tools

	The AudioSuite version of Neural UpMix must be used with mono tracks in Pro Tools in order to allow a different number of input channels and output channels.
	Let’s say, for instance, that you want to perform a stereo-to-5.1 upmix. First, you must create a Pro Tools project that contains mono tracks equal to the number of desired output channels. In this case, we need 6 mono tracks. Next, we load the L a...
	Group the tracks. To do this, you must first select an area the same length as the sound files, across all 6 tracks (see Figure 5-12).
	Right-click on the selected area to bring up the right-click menu (see Figure 5-13). Select the Group menu item.
	Pro Tools will now show the 6 tracks grouped together (see Figure 5-14).
	Go to the AudioSuite menu and select the UpMix that you want. In this case, select 2.0 to 5.1 (see Figure 5-15).
	On the plug-in, you must set the "playlist"/"region list" button to "playlist" (see Figure 5-16).
	Note: The AudioSuite plug-in does not currently support the use of presets saved within the RTAS plug-in, and vice-versa.
	You are ready to upmix. Click on the Process button to generate the 6 channels of upmixed audio (see Figure 5-17).
	Note: The resulting files are output according to the standard Pro Tools 5.1 channel order:
	6 Using the Neural UpMix plug-in in Nuendo

	Due to the upmixing process, the Neural UpMix plug-in will not have the same number of inputs and outputs. For example, if you are upmixing from stereo to 7.1, the Neural UpMix plug-in will have 2 inputs and 8 outputs.
	In Nuendo, you must create a track that has the same number of channels as the output of the Neural UpMix plug-in. So, if you do a stereo-to-5.1 upmix, you need a track with 6 channels. If you do a stereo-to-7.1 upmix or a 5.1-to-7.1 upmix, you need ...
	Next, drag the input audio file onto the newly created track. The plug-in accepts both interleaved stereo and interleaved 5.1 files. If you drag an interleaved stereo file onto a 5.1 or 7.1 track, Nuendo will put the input channels onto the first two...
	Then, go to the Inserts and select the Neural UpMix plug-in. This will bring up the Neural UpMix user interface (see Figure 6-20).
	Now when you play the input track, it will be processed through the Neural UpMix plug-in.
	To capture the upmixed audio, first you must select the waveform region to capture by moving the small triangles on the timeline. Then go to File > Export > Audio Mixdown. It will bring up a window where you will set the parameters for the capture to...
	Click on the Export button to capture the output file.


